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Computer-6

CHAPTER-1
HISTORY OF COMPUTERS

A.	1.	 (a)	 2.	 (c)
	 3.	 (c)	 4.	 (c)
	 5.	 (c)	 6.	 (b)
	 7.	 (b)	 8.	 (a)
B.	1.	 Personal Computer
	 2.	 Abacus
	 3.	 Stepped Reckoner
	 4.	 vacuum tubes
	 5.	 Visual Aids
	 6.	 Maps
C.	1.	 T	 2.	 T
	 3.	 F	 4.	 F
	 5.	 T	 6.	 T
D.	1.	 Characteristics of first-generation 

computers are:
	 •	 Vacuum tubes were used in circuits.
	 •	 These computers are very large in size.
	 •	 Programming for this generation was 

done using machine language.
	 •	 They were very expensive and require a  

large amount of electricity.
	 •	 They produce more heat.
	 •	 These computers could calculate data 

in millisecond.
	 •	 The technology used by first-generation 

computers is vacuum tubes.
	 2.	 Minicomputer
	 	 Minicomputers are mid-sized 

computers that fall between 
mainframes and microcomputers.

		  Example: DEC, PDP series.
		  They are different from other types of 

computer as:
	 •	 They are smaller and less powerful 

than mainframes but more robust than 
microcomputers 

	 •	 They are used for tasks that require more 

processing power than microcomputer 
could provide but didn't demand the 
scale and capabilities of mainframes.

	 3.	 Visual Aids: Visual aids are objects, 
images, or other materials that help 
enhance the learning experience 
by providing visual support for 
the information being presented. 
Visual aids play a crucial role in 
making learning more engaging and 
understandable.

	 4.	 There are give generation of computer.
		  1.	First Generation Computers
			   The first generation computers were 

used during 1940-1956. They were 
based on vacuum tbes.

		  2.	Second Generation Computers
			   As transistors developed, it helped 

in generating computers better than 
first generation.

		  3.	Third Generation Computers
			   During the period of 1964 to 1971, 

third generation computers were 
developed.

		  4.	Fourth Generation Computers
			   From 1972 onward the computers 

that we use for daily purposes are 
from the fourth generation.

		  5.	Fifth Generation Computers
			   Fifth generation computers are still 

is development.
	 5.	 1.	Images and Photographs: Displaying 

relevant images and photographs 
helps students visualise concepts, 
people, or places being discussed in 
the lesson.

		  2. Charts and Graphs: Simple charts 
and graphs help in presenting data 
and numerical information in a 
visual format, making it easier for 
students to comprehend.
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E.	1.	 Do your self
	 2.	 Do yourself

CHAPTER-2
ADVANCE MS WORD

A.	1.	 (b)	 2.	 (b)
	 3.	 (c)	 4.	 (a)
	 5.	 (b)	 6.	 (b)
B.	1.	 cell
	 2.	 Merging cell	 3.	 formatting
	 4.	 smaller cells	 5.	 Insert
C.	1.	 T	 2.	 T
	 3.	 T	 4.	 F	          5.	 F
D.	1.	 A table is made up of rows and 

columns. Tables are used to organise  
and represent information. The 
intersection of a row and column is 
called a cell. Each cell can contain text, 
paragraphs, or graphics.

	 2.	To insert table into a word document :
		  1.	 Open Microsoft Word: Launch 

Microsoft Word 2016 and open a 
new or existing document where 
you want to insert the table.

		  2.	 Place Cursor: Click to place 
the cursor in the location of the 
document where you want the table 
to appear.

		  3.	 Insert Table: Navigate to the 
''Insert'' tab on the Word ribbon at 
the top of the window. 

		  4.	 Click on ''Table'': In the "Tables" 
group, you'll see the option to 
Table. Click on it to open the drop-
down menu.

		  5.	 Select the Number of Rows and 
Columns: In the drop-down menu, 
hover over the grid to select the 
number of rows and columns for 
your table. Click on the grid to 
select the desired number of rows 
and columns.

		  6.	 Insert Table: Once you've selected 
the number of rows and columns, 
click on the grid. Word will insert 
the table into your document at 
the location where you placed the 
cursor.

	 3.	 Difference between rows and columns 
in a table is that a column arrange data 
vertically from top to bottom, which 
a raw arranges data horizontally from 
left to right.

	 4.	 Merging cells in a table refers to 
combining two or more adjacent cells 
into a single larger cell. This feature 
is commonly used to create headers 
or titles that span across multiples 
columns in a table. Merging cells in 
MS Word tables helps create a more 
visually appealing layout and allows 
for better organisation of information.

	 5.	 To Insert a new row in an existing 
table:

	 •	 Position the cursor in the table where 
you would like to insert a row. 

	 •	 Select the layout tab under Table 
Tools.

	 •	 Click either the Insert Above or Insert 
Below row buttons Rows & Columns 
Group.

	 6.	 To delete a table in Word document:
		  1.	Selected the table you want to 

delete
		  2.	Access the Table Tools Tab
		  3.	Click the Table Layout or Table 

Tools Layout tab in the Ribbon.
		  4.	Click delete in the Rows and 

columns group. A drop down menu 
appears.

		  5.	Select Delete table.
E.	1.	 Do yourself
	 2.	 Do yourself
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CHAPTER-3
MORE ON MS POWER 

POINT
A.	1.	 (b)	 2.	 (b)
	 3.	 (c)	 4.	 (b)         5.	 (b)

B.	1.	 slides	 2.	 Placeholder

	 3.	 Text	 4.	 Transitions

	 5.	 Entrance

C.	1.	 T	 2.	 F

	 3.	 T	 4.	 T           5.	F

D.	1.	 The purpose of using animations in 
Powerpoint presentations is that it 
helps capture the audience's attention, 
emphasise key points, and make 
presentations more engaging and 
dynamic.

	 2.	 Entrance effects make an object appear. 
Exit effect make an object disappear. 
Emphasis effects draw attention to an 
already-visible object.

	 3.	 Transitions provide a dynamic way to 
move from one slide to the next during 
a slide show. We can add a transition to 
just one slide, different transitions to 
different slides, or the same transition 
to all slides. Power Point makes it easy 
to apply transitions to some or all 
slides, giving presentation a polished, 
professional look.

	 4.	 1. Select the desired slide form the slide 
Navigation pane. This is the slide 
that will appear after the transition.

		  2.	 Click the Transitions tab, then 
locate the Transition to this slide 
group. By default, None is applied 
to each slide.

		  3.	 Click the More drop-down arrow 
to display all transitions.

		  4.	 Click a transition to apply it 
to the selected slide. This will 
automatically preview the 
transition.

	 5.	 1.	 Select the object want to animate.
		  2.	 On the Animations tab, click the 

More drop-down arrow in the 
Animation group.

		  3.	 A drop-down menu of animation 
effects will appear. Select the 
desired effect.

		  4.	 The effect will apply to the object 
will have a small number next to it 
to show that it has an animation. 
In the slide pane, a star symbol also 
will appear next to the slide.

	 6.	 Transition effects are animation 
options with in a presentation. 
Transition effects arte divided into 
three categories: Subtile, Exciting and 
Dynamic content.

		  A slide transition is the visual effect 
that occurs when you move from one 
slide to the next. Transition effects 
can control the speed and sound and 
customize the look.

E.	1.	 Do your self
	 2.	 Do your self
	 3.	 Do your self

CHAPTER-4
MS EXCEL

A.	1.	 (a)	 2.	 (b)
	 3.	 (d)	 4.	 (c)        5.	 (c)
B.	1.	 Spreadsheet	 2.	 A worksheet
	 3.	 workbook	 4.	 Cells
	 5.	 worksheet
C.	1.	 T	 2.	 T
	 3.	 T	 4.	 T	         5.	 F
D.	1.	 A worksheet or sheet is a single page 

in a file created with an electronic 
spreadsheet program such as Microsoft 
Excel or Google Sheets. A workbook 
is the name given to an Excel file that 
contains one or more worksheets. 
When we open an electronic 
spreadsheet program, it loads an 
empty workbook file consisting or one 
or more blank worksheets for us to 
use.
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	 2.	 Ms Excel is a commonly used Microsoft 

office application and it is available for 
windows, mac0S, Android, etc. It is a 
spreadsheet program which is used to 
save and analyse numerical data. In Ms 
Excel, formulas and functions are used 
for calculations, charts are used for 
graphical representation of data.

		  The tasks that we can do in Excel are:
	 •	 Entering tabular data
	 •	 To calculate large data
	 •	 To analyse student performance
	 •	 To interpret data
	 •	 Maintaining student records
	 3.	 Cells are the basic building blocks 

of a worksheet. Each rectangle on 
a worksheet is called a cell. The 
intersection of rows and columns is 
called a cell. A cell is identified by a 
combination of column name and row 
number.

		  The active cell is surrounded by bold 
line border, which is called cell pointer. 
The cell on. of the active cell will be 
displayed in name box. We mostly 
refer to a cell by its cell no. in other 
cells, worksheets, functions, formulas.

	 4.	 1.	Click Start button.
		  2.	 Click Excel 2016.
		  3.	 Select blank workbook.
		  4.	 A blank workbook will appear.
		  5.	 To modify that data of a cell:
			   (a)	 Double-click the cell with the 

text that we want to edit.
			   (b)	 Highlight the text that we want 

to change, or type in the text 
we want to add.

			   (c)	 Press enter to apply the 
changes, or press Escape (ESC) 
to cancel editing.

E.	1.	 Do yourself
	 2.	 Do yourself
	 3.	 Do yourself
	 4.	 Do yourself
	 5.	 Do yourself

F.	 1.	 Do yourself

CHAPTER-5
COMPUTER LANGUAGE

A.	1.	 (b)	 2.	 (c)
	 3.	 (b)	 4.	 (c)         5.	 (c)
B.	1.	 programming
	 2.	 Assembly
	 3.	 Object oriented
	 4.	 binary
	 5.	 Interpreter
C.	1.	 T	 2.	 T
	 3.	 F	 4.	 T          5.	 T
D.	1.	 (c)	 2.	 (a)
	 3.	 (e)	 4.	 (b)         5.	 (d)
E.	1.	 Low level languages are the basic 

computer instruction or better known 
as machine codes. A Computer cannot 
understand any instruction given to 
it by the user in English, Hindi or 
any other high level language. These 
low level languages are very easily 
understandable by the machine. 
This language is to interact with the 
hardware of the computer.

		  It is different from high level language 
as.

		  High level	 Low-level
		  language	 language
	 •	 These are	 •  These are
		  programmer	 machine friendly 
		  friendly languages	 languages
	 •	 They do not	 • They are machine
		  depend on	 dependent and
		  machines	 very difficult.
	 •	 Some examples	 • Some examples
		  are PASCAL, 	 are machine
		  FORTAN, C++, 	 language and 
		  etc	 Assembly 
			   language.
	 2.	 The different generation of 

programming languages are :
	 •	 1st Generation Language
	 •	 2nd Generation Language
	 •	 3rd Generation Language
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	 •	 4th Generation Language
	 •	 5th Generation Language
	 •	 6th Generation Language
		  Over time, programming languages 

have evolved to become more 
expensive, efficient and versatile.

	 3.	 High level languages are programming 
languages. Some prominent examples 
are PASCAL, FORTRAN, C++, etc.

		  The important feature of high level 
languages is that they allow the 
programmer to write programs for all 
types of computers and systems. Every 
instruction in high level language is 
converted to machine language for the 
computer to comprehend.

	 4.	 The characteristics and key features 
of each generation of programming 
languages are:

	 (a)	 1st Generation Language
		  •	 Translation of program is not 

required
		  •	 Program execution is very fast.
		  •	 It is efficient for the computer.
	 (b)	2nd Generation Language
		  •	 It is easy to understand.
		  •	 It requires less no. of instructions.
		  •	 Modification can be done easily.
		  •	 It is memory efficient.
	 (c)	 3rd Generation Language
		  •	 It is machine independent.
		  •	 Debugging is easy.
		  •	 Easy to learn.
		  •	 Less errors with more productivity,
	 (d)	4th Generation Language
		  •	 Development is fast.
		  •	 Easy to maintain.
	 (e)	 5th Generation Language
		  •	 Machines make decisions.
		  •	 Easier to learn and use than other 

languages.
		  •	 It solve problem with less effort.

	 5.	 This is also called as Natural Language. 
The fifth generation programming 
language (5GL) is based on problem-
solving. It uses constraints given to 
the program instead of an algorithm 
written by a programmer. It solves 
problems on its own using artificial 
intelligence or AI technology.

E.	1.	 Do your self

CHAPTER-6
INTRODUCTION TO 

PYTHON
A.	1.	 (c)	 2.	 (a)
	 3.	 (b)	 4.	 (a)        5.	 (b)
B.	1.	 .py	 2.	 lengthy
	 3.	 Values	 4.	 interactive
	 5.	 Title bar
C.	1.	 F	 2.	 T
	 3.	 F	 4.	 T	        5.	 F
D.	1.	 Do your self 
	 2.	 Different working mode of python 

are:
		  Interactive Mode: In this mode, 

the code is executed line by line and 
generate the output. Commands are 
type next to the command prompt. 
Interactive mode produces output that 
is displayed on the screen and then 
disappears. 

		  Script Mode: This mode is used when  
the user is working with more than 
one single code or a block of code.

	 3.	 The use of print ( ) function is used to 
display the output of any command on 
the screen. It can also be used to print 
any message.

	 4.	 For application areas of Python are :
		  (1)	Python can be used to make web-

applications.
		  (2)	Python is also used in the 

development of interactive games.
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		  (3)	Python in used to develop artificial 

applications.
		  (4)	This language is also used for the 

programming of robots.
	 5.	 Variables are used to store data, while 

data types, such as integers, floats, and 
strings, define the nature of the stored 
information.

E.	Do yourself

CHAPTER-7
IMAGE PROCESSING 
BASICS WITH GIMP

A.	1.	 (d)	 2.	 (b)
	 3.	 (a)	 4.	 (a)        5.	 (c) 
B.	1.	 spray paint	 2.	 Ellipse select
	 3.	 Layers	 4.	 scale
	 5.	 Smudge 
C.	1.	 (T)	 2.	 (T)
	 3.	 (T)	 4.	 (T)       5.	 (F)
D.	1.	 GIMP is a freeware and open source 

graphic editing tool. It is an acronym of 
GNU Image Manipulation Program. 
This software is used for image editing 
and retouching, free form drawing, 
converting images into  different 
formats and for more specialised

 	 2.	 (a)	Text tool : It is used to add text on 
the image.

		  (b)	Brush : It allow us to paint.
		  (c)	Pencil : It is used to draw free hand 

lines with a hard edge.
		  (d)	Smudge : It is used to give wet 

paint effect of an image.
		  (e)	Gradient : It is used to fill the 

selection with a colour bend.
	 3.	 Five major parts of GIMP windows 

are:
		  (1)	Menu Bar
		  (2)	Toolbox
		  (3)	Docks or Dialogs Area
		  (4)	Canvas or Image
		  (5)	Status Bar

	 4.	 Three properties of GIMP tool are :
		  Rounded corners: This property sets 

the roundedness of the corners of a 
rectangular selection. 

		  Opacity: This property sets the 
transparency/opacity of the colour. 

		  Feather edges: Selection tools have 
this property to define how much part 
around the selection would be little 
blur.

	 5.	 Filters are special effects that can be 
applied to an image or a selected 
region. Filters enhance the look of the 
image. Filters are organized in several 
categories available as submenus under 
the Filters menu. 

		  To apply a filter: 
		  Select the desired region in the image 

on which filter is to be applied. 
		  Select desired filter from the set of 

submenus under Filters menu. 
E.	Do yourself

CHAPTER-8
INTERNET

A.	1.	 (b)	 2.	 (c)
	 3.	 (a)	 4.	 (b)
B.	1.	 Internet	 2.	 Tim Berners-Lee
	 3.	 Web	 4.	 search engine
	 5.	 symbols
C.	1.	 F	 2.	 T
	 3.	 T	 4.	 T	         5.	 T
D.	1.	 Opera		  2.	Safari
	 3.	 Internet Explorer		 4.	Firefox
	 5.	 Chrome		  6. Edge
E.	1.	 World wide web
	 2.	 Advance Research Project Agency 

Network
	 3.	 Uniform Resource Locator
	 4.	 Department of Defence
F.	 1.	 A search engine is a software system 

that allows Internet users to search 
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for content via the World Wide Web 
(WWW). A user enters keywords or 
key phrases into a search engine and 
receives a list of Web content results in 
the form of websites, images, videos or 
other online data that best match with 
the search query.

		  Some of the search engines are : 
Yahoo!, Google, etc

	 2.	 The Internet is a vast global network 
that connects computers all over 
the world. Through the Internet, 
people can share information and 
communicate from anywhere with an 
Internet connection. It also helps in 
the transfer of messages through mail, 
chat, video & audio conference, etc.

	 3.	 •	 History of Internet—
			   In 1960, the technology began 

when USSR launched it's satellite 
named sputnik.

		  •	 At the end of 19th century, the 
Internet was came into existence 
with the structure of sharing 
messages, information, etc.

		  •	 In 1960, the Internet began as a 
project called ARPANET

		  •	 In 1970, the Internet grew, 
connecting more places. 

		  •	 In 1989, a person named Tim 
Berners-Lee created the World 
Wide Wed (WWW) to make it easy 
for scientists to share information. 

		  •	 In 1990, The Internet became 
available to everyone. Websites, 
email, and services like AOL 
(America Online) became popular.

		  •	 Late 1990's, many new companies 
started online. This was called the 
dot-com boom.

		  •	 In 2000, social media like Facebook 
and Twitter became popular. 

		  •	 In 2007. the iPhone came out, and 

now people could use the Internet 
on their phones. 

		  •	 Today, the Internet is a huge part 
of our lives. 

	 4.	 (a)	A web browser is the software 
installed on your computer or 
mobile that allows you to view 
web pages. On the web, when 
you navigate through pages of 
information, this is commonly 
known as web browsing or web 
surfing.

		  (b)	The world Wide Web (WWW) 
was developed in 1991 by Tim 
Berners-Lee. World Wide Web, is 
also known as a Web, is a collection 
of websites or web pages stored in 
web servers and connected to local 
computers though the Internet. 
These websites contain text pages, 
digital images, audios, videos, etc. 

		  (c)	A website is like a digital place on 
the Internet where you can find 
information, play games, watch 
videos, and do many other things. 
It's like a virtual space where you 
can explore and learn.

		  (d)	A web address, or URL (Uniform 
Resource Locator), is like the 
address of a house on the Internet. 
It tells computer where to find a 
specific website.

CHAPTER-9
ARTIFICIAL INTELLIGENCE

A.	1.	 (b)	 2.	 (b)
	 3.	 (b)	 4.	 (b)
	 5.	 (c)	 6.	 (b)
	 7.	 (c)	 8.	 (b)
	 9.	 (b)	 10.	 (b)
B.	1.	 diseases
	 2.	 AI
	 3.	 The Virtual Tutors



25Computer Answer Key 1 to 8
	 4.	 Technical issues
	 5.	 Radiology
	 6.	 Predictive Maintenance.
	 7.	 Chatbots
	 8.	 help
	 9.	 Privacy and Fairness
	 10.	Sensors
C.	1.	 F	 2.	 T
	 3.	 F	 4.	 F
	 5.	 T	 6.	 T
	 7.	 F	 8.	 F
	 9.	 F	 10.	 F 
D.	1.	 Artificial intelligence refers to computer 

systems capable of performing 
complex tasks that historically only a 
human could do, such as reasoning, 
making decisions or solving Problems.

		  AI is different from traditional 
computer programming as AI is 
about creating algorithms that allow 
computer to learn from data and 
make decisions or predictions, which 
traditional computer programming 
does not.

	 2.	 Artificial Intelligence (AI) has emerged 
as a transformative force in the field 
of healthcare, revolutionising the 
way medical professionals diagnose 
diseases, treat patients, and manage 
healthcare systems. From personalised 
medicine to predicitve analytics, AI is 
reshaping the landscape of healthcare 
delivery in profound ways. 

	 3.	 1.	 Increased Efficiency: AI optimises 
production processes, reducing 
time and costs.

		  2.	 Improved product Quality: AI 
enhances quality through precise 
monitoring and control.

		  3. 	 Enhanced Customer Experience: 
AI personalises shopping 
experiences and improves customer 
service.

		  4.	 Inventory Management: AI ensures 
optimal stock levels, reducing 
overstock and stockouts.

		  5.	 Predictive Analytics: AI forecasts 
demand, helping manufactures 
and retailers plan better.

	 4.	 The role of artificial intelligence 
in education and its potential to 
personalise learning experience for 
students are :

		  1.	 Personalized Learning : AI tailors 
lessons to each student's needs and 
abilities.

		  2.	 Interactive Learning : AI provides 
engaging, interactive learning 
experiences for students.

		  3.	 Efficient Feedback: AI gives instant 
feedback to students, helping them 
improve faster.

		  4.	 Accessibility: AI enables learning 
form anywhere, making education 
more accessible.

		  5.	 Teacher Support: AI assists teachers 
with grading, lesson planing, and 
individualised instruction.

	 5.	 1.	 Initial Investment: Implementing 
AI Technology requires significant 
upfront costs of farmers.

		  2.	 Dependency on Technology: 
Overreliance on AI may reduce 
farmer's traditional farming skills.

		  3.	 Data Security Risks: AI systems 
store sensitive agricultural data, 
raising concerns about privacy and 
security.

		  4.	 Limited Access: Small-scale 
farmers may have limited access 
to AI technology due to cost and 
infrastructure constraints.

		  5.	 Ethical Concerns: AI decision-
making may rise ethical questions 
regarding crop managements and 
biodiversity.

qq
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Computer-7
CHAPTER-1

NUMBER SYSTEM
A.	1.	 (c)	 2.	 (a)
	 3.	 (c)	 4.	 (c)
	 5.	 (d)
B.	1.	 A binary
	 2.	 decimal
	 3.	 Most
	 4.	 numbers
	 5.	 alphanumeric

C.	1.	 F	 2.	 F
	 3.	 F	 4.	 T
	 5.	 T
D.	1.	 A binary number system has only 

two digits that are 0 and 1. The base 
of the binary number system is 2 
because it has only two digits. In any 
binary number, the rightmost digit is 
called the least significant bit (LSB) 
and leftmost digit is called the most 
significant bit (MSB).

	 2.	 Binary Number is : (11000000111001)2

1 1 0 0 0 0 0 0 1 1 1 0 0 1
13 12 11 10 9 8 7 6 5 4 3 2 1 0

1×213 1×212 1×210 1×210 1×29 1×28 1×27 1×26 1×25 1×24 1×23 1×22 1×22 1×20

8192 4092 0 0 0 0 0 0 32 16 8 0 0 1
		  = 8192 + 4096 + 32 + 16 + 8 + 1 = 12345
	 3.		 Advantages and disadvantages of 

Binary Number System :
 		  Advantages : 
	 •	 Data can be stored and sent with 

ease since all potential values are 
represented by two symbols 0 and 1.

	 •	 It is a base which is easily represented 
by electronic devices.

		  Disadvantages :
	 •	 Difficult for most people to read.
	 •	 Takes a lot of digits to represent any 

reasonable number. 
		  Decimal Number System :
 		  Advantages : 
	 •	 Easy readability
	 •	 Used by humans
	 •	 Easy to manipulate
		  Disadvantages : Wastage of space and 

time.
		  Octal Number System :
		  Advantages : It is easy to convert to 

any other number system; because of 
less digits.

		  Disadvantages : Computer does not 
understand the octal numbers in direct 

way, first it has to be converted into 
binary numbers.

		  Hexadecimal Number System:
		  Advantages :
	 •	 They are compact and use less memory.
	 •	 Their small size makes inpout-output 

handling easier.
	 •	 They are also useful to represent 

computer memory addresses.
		  Disadvantages :
	 •	 It can be difficult to perform complex 

mathematical operations.
	 •	 It is also difficult to read and write 

compared to decimal numbers.
	 4.		 Computers perform all of their 

operations using the binary, or base 
2, number system. All program code 
and date are stored and manipulated in 
binary number is known as a bit (for 
binary digit) and can have only one of 
two values, 0 or 1. Bits are commonly 
stored and manipulated in groups of 8 
(known as a byte), 1G (usually known 
as a halfword), 32 (a word), or 64 bits 
(a double word). Sometimes other 
groupings used.

E.	•	 Do your self
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CHAPTER-2
ADVANCE MS WORD

A.	1.	 (a)	 2.	 (b)
	 3.	 (c)	 4.	 (b)
	 5.	 (b)
B.	1.	 multimedia
	 2.	 chart
	 3.	 normal
	 4.	 vertical
	 5.	 Split
	 6.	 Surface
C.	1.	 T	 2.	 F
	 3.	 T	 4.	 T
	 5.	 T	 6.	 T
D.	1.	 A chart is a graphical or pictorial 

representation of data. Charts allow 
users to illustrate numerical data 
such as comparisons etc.. to better 
understand and also predict current 
and future data.

	 2.	 A style is a predefined combination of 
font style, color, and size that can be 
applied to any text in your document. 
Applying a style gives text element a 
specific formatting definition that 
can be consistently applied and 
easily updated. New documents 
automatically use the Normal style.

	 3.	 Step involved in inserting a chart into 
an MS word document are:

	 1.	 Click Insert > Chart.
	 2.	 Click the chart type.
	 3. 	 Select the desired chart, then click ok.
	 4.	 In the spreadsheet that appears, replace 

the default data with own information.
	 5.	 Enter source data into the spreadsheet.
	 6.	 When finished, close the spreadsheet.
	 7.	 The chart will be completed.
	 8.	 If want, use the Layout Options 

button to arrange the chart and text in 
document.

		  The use of different type of charts 
are:

		  Column Charts:
		  A column chart is represented in 

vertical columns means vertical bars 

are used to represent date. The column 
height of each category is proportical 
to the values plotted. 

		  Line Chart:
		  It is a chart that shows a line joining 

several points or a line that shows 
the relation between the points. It is 
commonly drawn to show information 
that changes over time.

		  Pie Chart:
		  Pie chart is a circular representation of 

data. It is called a pie chart because the 
sectors of the circles are just slices of a 
pie. The area within each sector (slice) 
represents the size of the data.

		  Bar Chart 
		  Bar charts are similar to column charts 

and both display data in rectangular 
bars. But a bar chart plots the variable  
value horizontally, and the fixed 
dimension  vertically. 

		  Area Chart

		  Area charts are just like line charts, 
except the areas under the lines are 
filled in.

		  Surface Chart

		  Surface chart is actually a 3D chart 
that helps to represent the data into 
a 3D landscape. These charts are best 
to use with a large dataset. This chart 
allows to displaying a variety off data 
at the same time.

	 4.	 A table style holds a set of table, row, 
cell, paragraph and text formatting that 
can be applied to tables. Using table 
styles instead of directly formatting a 
table saves time in modifying the look 
of a table and switching to a different 
table style.

	 5. 	 To add data to a chart in MS word :

		  (i) 	Click Insert > Chart
		  (ii) Click the chart type and then 

double click the chart you want.
		  (iii) In the spreadsheet that appears. 
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replace the default data with your own 
information.

		  (iv) When you're finished, close the 
spreadsheet.

E.	1.	 Do your self
	 2.	 Do your self
	 3.	 Do your self
	 4.	 Do your self

CHAPTER-3
ADVANCE POWER POINT

A.	1.	 (a)	 2.	 (b)
	 3.	 (b)	 4.	 (a)
	 5.	 (c)	
B.	1.	 theme
	 2.	 taskbar
	 3.	 shape
	 4.	 Mouse
	 5.	 ESC
C.	1.	 T	 2.	 F
	 3.	 T	 4.	 T
	 5.	 T
D.	1.	 Steps to add an audio to a 

presentation
	 1.	 Click on Insert tab and look for media 

group.
	 2.	 Click on audio option and choose 

Audio on My PC option from the list 
that appears.

	 3.	 Insert Audio dialog box appears.
	 4.	 Choose the required audio file and 

click the insert button.
	 5.	 Selected audio will be added to the 

side.
		  Steps to add a video to a presentation
	 1.	 Click on Insert tab and look for media 

group.
	 2.	 Click on video option and choose 

video on My PC option from the list 
that appears.

	 3.	 Insert video dialog box appears.
	 4.	 Choose the required video file and 

click the insert button.
	 5.	 Selected video will be added to the 

slide.

	 2.	 Presenter view gives access to a special 
set of controls on screen that the 
audience won't see, allowing presenter 
to easily reference slide notes, preview 
the upcoming slide, and much more.

	 3.	 A theme is a predefined combination 
of fonts, colors and effects. Different 
themes also use different slide layouts. 
The defaults theme is MS office theme. 
It help in creating presentation by 
giving entire presentation a consistent 
professional look.

	 4.	 To access slide show setup options:
	 1.	 Select the Slide Show tab, then click 

the Set Up Slide Show command. 
	 2.	 The Set Up show dialog box will 

appear. Form here, we can select the 
desired options for our presentation.

		  Click the buttons in the setup show 
dialog box below to learn about various 
options for setting up and playing a 
slide show.

		  To advance slides automatically, we'll 
need to customize the slide timing on 
the Transitions tab.

	 5.	 Slide Sorter view display all the slide in 
presentation in horizontally sequence 
or in thumbnail form. This make it 
useful in organising and arranging 
slides, just by dragging and dropping 
them wherever we want. 

E.	1.	 Do your self

CHAPTER-4
MORE ON MS EXCEL

A.	1.	 (b)	 2.	 (b)

	 3.	 (c)	

B.	1.	 Three

	 2.	 Save

	 3.	 cell

	 4.	 Text

	 5.	 Delete
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C.	1.	 T	 2.	 T
	 3.	 F	 4.	 F
	 5.	 F
D.	 Steps are as follows:
	 1.	 Click the file tab and select Save As 

option.
	 2.	 Select a location where you would 

like to save the sheet, Enter file name, 
which you want to give to your sheet 
and select a Save as type, by default it 
is. xlsx format.

	 3.	 Click on Save button and sheet will be 
saved.

		  Saving work regularly is important as 
in case the computer frezes, crashes 
or restarts, then unsaved work will be 
lost. 

	 2.	 Click the File tab > New > Blank 
Workbook icon

		  A new blank workbook will appear.
	 3.	 You can edit the contents of a cell 

directly in the cell you can also edit 
the contents of a cell by typing in the 
formula bar.

		  When you edit the contents of a cell, 
Excel is operating in edit mode. Some 
excel features work differently or are 
unavailable in edit  mode.

		  When Excel is in edit mode the word 
edit appears in the lower - left corner 
of the excel program window.

	 4.	 Cut : Cutting in Excel, cut or remove 
a file from one folder and pasting it to 
another.		  Copy : 
Copying in Excel simply copies the 
data or formula from one cell to 
another, leaving the original data in 
the original cell.

		  To use Copy and Paste:
	 1.	 Select the cell as we have selected B9:
	 2.	 Click the Copy command on the 

Home tab, or press ctrl+C on keyboard.
	 3.	 Select the cell where you want to paste 

the copied data. We have selected D8 
to D13.

	 4.	 Click the Paste command on the Home 
tab, or press Ctrl+V on keyboard.

	 5.	 The content will be pasted into the 
selected cells. 

		  To use Cut and Paste:
	 1.	 Select the cell as we have selected 

D8:D13
	 2.	 Right-click the mouse and choose the 

Cut command or, you can use the 
command on the Home tab, or press 
Ctrl+X on Keyboard.

	 3.	 Select the cells where you want to paste 
the content. We have pasted content 
to F8: F13 and the cut content will be 
removed from D8:D13.

	 5.	 To open a workbook in excel :
	 1.	 Click the File tab and choose Open.
	 2.	 The Open dialog box appears.
	 3.	 Browse the directory and find the file 

you need to open.
	 4.	 Click the file you want to open and 

then click the Open button, or double 
- click the file's icon.

E.	1.	 Do your self
CHAPTER-5

PROGRAMMING IN 
PYTHON

A.	1.	 (c)	 2.	 (a)
	 3.	 (c)	 4.	 (b)
	 5.	 (b)
B.	1.	 reserved
	 2.	 variable
	 3.	 three
	 4.	 Float
	 5.	 string
C.	1.	 F	 2.	 T
	 3.	 T	 4.	 F
	 5.	 T
D.	1.	 A variable is a container for a value. It 

can be assigned a name, you can use it 
to refer to it later in the program.

	 2.	 The python type ( ) function print 
what type of data structures are used to 
store the data elements in a program.

	 3.	 Global variable:- Global variable in 
python are those which are not defined 
inside any function and have a global 
scope. This variable are accessible 
throughout the program and inside 
every function.
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		  Local Variables: Local variables in 

python are those which are initialized 
inside a function and belong only to 
that particular function. It cannot 
be accessed anywhere outside the 
function.

	 4.	 Various naming rules for Python 
Variables are:

	 •	 A variable name must start with a 
letter or the underscore character.

	 •	 A variable name cannot start with a 
number.

	 •	 A variable name can only contain 
alpah-numeric characters and 
underscores (A-z, 0-9, and –).

	 •	 Variable names are case-sensitive 
(age, Age and AGE are three different 
variables).

	 •	 A variable name cannot be any of the 
Python keywords.

	 5.	 We can display a character from a 
string using its index in the string. 
Remember, indexing starts with 0.

		  >>> doctor='appointment'
		  >>> doctor [0]
		  Output
		  'a'
		  We  can also display a substring from a 

string using the slicing operator [].
		  >>> doctor [2:7]
		  Output
		  'point'
		  This prints the characters from 2 to 6.
E.	1.	 Do your self

CHAPTER-6
MORE ON PYTHON

EXERCISE
A.	1.	 (b)	 2.	 (c)
	 3.	 (a)	 4.	 (a)
	 5.	 (c)
B.	1.	 keyboard
	 2.	 string
	 3.	 \n
	 4.	 conditional
	 5.	 Print ( )

C.	1.	 T	 2.	 F
	 3.	 T	 4.	 T
	 5.	 F
D.	1.	 For Loop: For loop execute a block of 

code, a fixed number of times. You can 
iterate over a range, string, sequence 
etc.

	 2.	 The types of loops in python are:
	 •	 For Loop
	 •	 While loop
	 3.	 Python if...elif...else Statement
		  A user can choose from a variety 

of alternatives here. In this variant 
of 'if statement', there are many 
else if conditions declared. If the 
condition does not satisfy then the 
next condition is executed. But if this 
condition also does not satisfy then the 
next condition is executed. Let us look 
at the syntax and the flowchart of if...
elif... else statement.

	 4.	 Python Functions

		  A Python Function is a block of code 
which only runs when it is called and 
performs a specific task. 

		  We can pass data, known as parameters, 
into a function. 	A function can return 
value (data) as a result.

		  For Example:
		  def fun( ):
		       print ('Hello')
		  Here def is keyword used to create 

a function. fun( ) is the name of 
function.

		  Print('Hello') is the body of function.
	 5.	 We return a value from the function 

using the return statement.
	 Example: Finding cube of a number using 

return statement.
	 1.  	Cube of a number 27
	 2.	 det Find cube(run)
	 3.	 Result = run = run = run
	 4.	 Return result
	 5.	
	 6.	 = calling function
	 7.	 cube = Find - cube (3)
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	 8.	
	 9.	 Print ('cube of number, code)
	 In the above example, we have created a 

function named find–cube(). The function 
accepts a number and returns the cube of 
the number.

E.	1.	 Do your self
CHAPTER-7

INTRODUCTION TO HTML
EXERCISE
A.	1.	 (b)	 2.	 (b)
	 3.	 (a)	 4.	 (c)
	 5.	 (b)
B.	1.	 text
	 2.	 Server
	 3.	 Web browser
	 4.	 document
	 5.	 Web pages
C.	1.	 T	 2.	 T
	 3.	 T	 4.	 F
	 5.	 T
D.	1.	 HTML is Hypertext Markup 

Language. It is used to create web 
pages.

	 2.	 (1) HTML documents are simple text 
files.

		  (2) Compiling is not required in 
HTML.

	 3.	 Step 1 : Open Notepad.
		               Type the HTML code.
		  Step 2 : Click on the File menu to 

save. Save as dialogue box will appear.
		  Step 3 : Make the choice of the folder, 

where file is to be saved and type a file 
name followed by extension. htm or 
.html.

		  Step 4 : Click on Save button.
	 4.	 To create, use text editor.
		  To view, use web browser.
	 5.	 Web browser is used to view and 

display the HTML documents.
E.	1.	 Do your self

CHAPTER-8
INTRODUCTION TO FLASH

EXERCISE
A.	1.	 (b)	 2.	 (b)
	 3.	 (d)	 4.	 (d)
B.	1.	 width	 2.	 name
	 3.	 commands	 4.	 Pencil tool
	 5.	 two
C.	1.	 T	 2.	 F
	 3.	 T	 4.	 F
	 5.	 T
D.	1.	 (1) Title Bar : It shows name of the 

currently open file.
	 (2)	Stage : It shows work done.
	 (3)	Menu Bar : It carries all commands, in 

flash.
	 (4)	Color Palette : It has a variety of 

colours.
	 (5)	Work Area : It is the place on both 

sides of the stage.
	 (6)	Timeline Panel : It controls the 

organised file content overtime in layer 
and frames.

	 (7)	Tools Panel : It contain different tools 
to choose from.

	 (8)	Property Inspector: It can organise 
and modify the properties of current 
selection.

	 2.	 Brush tool enables the user to draw 
thick strokes of line.

	 3.	 Color Palette has a variety of colors to 
work with.

	 4.	 Four ways in which free transform tool 
works are :

		  1. Distort
		  2. Scale
		  3. Rotate and skew
		  4. Envelop
	 5.	 Text Tool enables the user to add text 

working.
		  Steps to add text :
		  Step 1 : Click on Text tool.
		  Step 2 : Adjust the text color, font and 

font size.
		  Step 3 : Types the text.
E.	1.	 Do your self
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LESSON - 9

MORE ON INTERNET
EXERCISE
A.	1.	 (b)	 2.	 (d)
	  3.  (b)	 4. 	 (a)	            
     5.  (c)
B.	 1. Cyber security
	 2.	 browser
     3.	 phrases
	 4.	 teacher, students and parents
     5.	 Country
	 6.	 country
C. 1. (T)	 2.(T)   
     3. (T)	 4. (F)
     5. (F)	 6. (T)
     7. (T)	 8. (T) 
     9.(F)	 10.(T)
D. 1. A search engine is like a big library 

where we can look for information on 
almost any topic. It is a website that 
helps us to find other websites, articles, 
pictures , and videos.

		  When we want to find something 
online, we type a word or phrase related 
to our topic into the search bar of a 
search engine, like Google or Bing. 	
The search engine then looks through 
its vast collection of information, 
which is called an index, to find web 
pages that match our search words.

	 2.	 Three popular web search engines are:
		  Google, Bing, Yahoo!
		  Google : It allows Android users to 

search anything on their screen by 
simply circling or highlighting it.

		  Bing : It affers higher-quality images 
with more detailed information.

		  Yahoo! : It allows to see what we've 
searched for in the past.

	 3.	 DIKSHA stands for Digital 
Infrastructure for Knowledge Sharing. 
The Diksha portal is an online platform 
developed by the Indian government 
to provide digital educational resources 
and tools to teachers, students, and 

parents across the country. The Diksha 
portal is like a magical treasure trove 
of educational resources that students 
and teachers can explore to make 
learning and teaching more enjoyable 
and effective. It's wonderful tool to 
help everyone in their educational 
journey!

	 4.	 Swayam, stands for Study Webs of 
Active Learning for Young Aspiring 
Minds, is an online platform 
introduced by the Government of 
India to offer free online courses to 
learners across the country. Swayam 
is like a digital treasure trove of 
educational opportunities that 
students and learners of all ages can 
explore to discover new interests 
and enhance their understanding of 
various subjects. It's a fantastic tool to 
support lifelong learning and personal 
growth!

	 5. " PM e- Vidya" is an initiative launched 
by the Government of India to provide 
digital education and online learning 
resources to students across the 
country. PM e- Vidya is like a digital 
classroom that brings education to our 
fingertips. It's a wonderful tool to help 
students learn, explore, and grow, even 
when they can't be physically present 
in a traditional classroom setting.

	 6.	 Cybersecurity is like a shield 
that protects our devices, such as 
computers, tablets, and smartphones, 
from bad things on the internet.

		  It is important as it helps to keep our 
online information safe from hackers 
and bad people who might want to 
steal it or do harm.

E.	Do yourself

LESSON - 10
CLASSIFICATION OF AI

A.	1. (a)	 2.(b)
	 3. (c)	 4.(a)
	 5. (a)	
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B.	1. Super AI
	 2.personalized
	 3.real- time
	 4.security
	 5.learning
	 6.accurately and quickly
C. 1.(T)	 2.(F)
	 3.(T)	 4.(T)
	 5.(F)
D. 1.	 Narrow AI, also know as weak AI,refers 

to AI systems that sre designed and 
trained for a specific task or set of tasks. 
These systems excel in performing a 
narrow range of tasks within a well- 
defined domain.

		  An example of Narrow AI that we 
use in our daily life include virtual 
personal assistants like Siri or Alexa.

	 2.	 General AI, also know as Strong AI or 
Artificial General Intelligence (AGI), 
refers to AI systems that have the 
ability to understand learn, and apply 
knowledge across a wide range of tasks 
and domains.

		  These systems would exhibit human-
like intelligence and cognitive abilities, 

including reasoning, problem - 
solving, creativity, and emotional 
understanding.

		  Unlike Narrow AI, General AI would 
be capable of learning new tasks 
and adapting to new environments 
without the need for reprogramming 
or significant human intervention.

	 3.	 Superintelligence refers to a 
hypothetical level of intelligence that 
surpasses the cognitive capabilities 
of humans across all domains and 
activities.

		  Unlike Narrow AI and General AI, 
Super AI surpasses human intelligence, 
performing any task better than 
humans.

	 4.	 Virtual personal assistants like Siri, 
Alexa and Google Assistant use AI 
to understand natural language 
commands and perform tasks such as 
setting reminders, sending messages, 
and answering questions. They 
make daily life more convenient and 
efficient.

E.	Do your self
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Computer-8
CHAPTER-1

NUMBER SYSTEM
A.	1.	 (b)	 2.	 (a)
	 3.	 (a)	 4.	 (b)
	 5.	 (c)
B.	1.	 Octal	 2.	 10
	 3.	 0	 4.	 16
	 5.	 Bits
C.	1.	 F	 2.	 T
	 3.	 F	 4.	 F
	 5.	 T
D.	1.	 Divide the number by 2 till we get 1 

as the quotient. Then starting from 
the last remainder write all the from 
left to right get the binary equivalent 
number. 

	 2.	 Number system is a system of 
reprocessing number in various ways. 
It denotes group of character which 
denote various numerical quantities. 
There are various kinds of number 
system e.g., Decimal, Hexadecimal, 
Octal and Binary number systems.

	 3.	 2	 69	 Remainder 1
		  2	 34	 Remainder 0
		  2	 17	 Remainder 1
		  2	 8	 Remainder 0
		  2	 4	 Remainder 0
		  2	 2	 Remainder 0
			   01	 Remainder 1
		  (69)10 = (1000101)2
	 4.	  10101
	           1101
		  100010
	 5.	 (1111)2 and (1001)2

	  	              1111
		             ×1001
                       1111
                     0000×
	                0000××
	              1111×××
                10000111			 
E.	•	 Do your self

CHAPTER-2
MS EXCEL: FUNCTIONS 

AND FORMULAS
A.	1.	 (a)	 2.	 (a)
	 3.	 (a)	 4.	 (a)         5.	 (d)
B.	1.	 Windows	 2.	 Worksheets
	 3.	 Clear contents	4.	 Insert > Comments
	 5.	 Auto sum.
C.	1.	 T	 2.	 F
	 3.	 T	 4.	 T	         5.	 T
D.	1.	 Five formatting tools available on 

Home tab in Excel are :
		  a. Font name b. Font size c. Alignment 
		  d. Wrap text e. Merge & Center
	 2.	 A formula is an equation that performs 

a calculation. Like a calculator, Excel 
can execute formulas for addition, 
subtraction, multiplication and 
division.

	 3.	 Type an equal sign (=) and then type 
a function for example = SUM for 
getting the total sales. Type an opening 
parenthesis (select the range of cells, 
and then type a closing parenthesis).

	 4.	 The steps to apply a colourful border 
to a cell in a worksheet is

		  a.	 Click on Border tab.
		  b.	Click on the drop-down arrow and 

select the desired colour.
		  c.	 Click on ok button.
	 5.	 The Alignment tab is where you place 

text and numbers in cells, modify 
their orientation and specify the text 
control.

 	 6.	 To perfrom basic mathematical 
operations, arithmetic operators 
are used. For example, + (Plus sign) 
for addition, – (Minus sign) for 
subtraction, * (asterisk sign) for 
multiplication, / (forward slash) for 
division, % (Percentage sign) for 
percentage and (^) carat for exponents.
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	 7.	 Formatting text or number can make 

them appear more visible  especially 
when you have a large worksheet. 
Changing default formats includes 
things like changing the font colour, 
style, size, text alignment in a cell, or 
apply formatting effects.

E.	1.	 An equal sign is must to be at the start 
of each formula.

	 2.	 Rahul used plus (+) sign to perfrom 
addition on the computer.

	 3.	 Rahul used multiplication (*) sign 
to perform multiplication on the 
computer.

CHAPTER-3
MS EXCEL: USING CHARTS 

TO PRESENT DATA
A.	1.	 (b)	 2.	 (b)
	 3.	 (d)	 4.	 (a)        5.	 (b)
B.	1.	 F11	 2.	 Items
	 3.	 Tools	 4.	 Interconnected
C.	1.	 T	 2.	 F
	 3.	 T	 4.	 F	          5.	 T
D.	1.	 A chart is a tool that  can use in Excel 

to represent data pictorially. Charts 
allow audience to see the meaning 
behind the numbers, and they make 
representing comparisons and trends 
much easier.

	 2.	 Various types of charts that can be 
created in MS Excel are :

		  Column Chart
		  The information is shown in vertical 

columns in this chart. It typically 
displays categories along the horizontal 
axis and values along the vertical axis. 
It allows you to compare two or more 
items in a single category of data.

		  Line Chart
		  A line graph (line chart or run chart), 

in this chart, data is plotted in the 
from of line with connecting dots. It 
displays categories along the horizontal 
axis and values along the vertical axis.

	 	 Pie Chart
		  In this chart, data is displayed in the 

form of circles that shows this size of 
items in one data series, proportional 
to the sum of the items.

	 	 Bar Chart
		  In this chart, data is displayed in the 

form of horizontal bars. It displays 
categories along the vertical axis and 
values along the horizontal axis.

		  Area Chart
		  An area chart is a primary Excel 

chart type, with data series plotted 
using lines with a filled area below. 
Area Charts are a good way to show 
magnitude of change over time. 

		  Funnel Chart
		  A funnel chart is a visual representation 

of progress across certain stages. This 
chart should have at least 3 stages to 
show.

	 3.	 Steps to move a chart on the worksheet:
		  a. The mouse pointer transforms into 

a moving handle when you point it 
anywhere on the chart.

		  b. Click and drag the chart to new 
location.

	 4.	 To change the chart style in a worksheet
		  a. Select the chart on the worksheet. 

The chart tools (having Design and 
Format tabs) appear on Ribbon.

		  b. Click on Design tab.
		  c. Select the desired style from the 

menu by clicking the chart style drop-
down button.

	 5.	 To move a chart on the worksheet:
		  a. The mouse pointer transforms into 

a moving handle when you point it 
anywhere on the chart.

		  b. Click and drag the chart to new 
location.

	 •	 To resize a chart on the worksheet:
		  Put mouse cursor on the corner of the 

chart and drag it diagonally.
	 •	 To print out the chart:
		  Select the chart and press Ctrl+P.
	 6.	 The Steps to insert a picture in the 

worksheet are:
		  a. Select any cell.



36 Computer Answer Key 1 to 8
		  b. Click the Pictures tool in the 

Illustrations group on the Insert Tab. 
The dialog window for inserting a 
picture appears. 

		  c. Locate the required image and select 
it.

		  d. click on Insert button.
		  The selected image is inserted in the 

worksheet.
E.	1.	 By using Column Chart
	 2.	 By using Pie Chart
	 3.	 By using Bar chart

CHAPTER-4
CLOUD COMPUTING

A.	1.	 (a)	 2.	 (d)
	 3.	 (c)	 4.	 (a)         5.	 (c)
B.	1.	 Private	 2.	 IaaS, PaaS, SaaS
	 3.	 Paas
	 4.	 Google online storage
	 5.	 Trash
C.	1.	 F	 2.	 T
	 3.	 F	 4.	 F	           5.	T
D.	1.	 Cloud computing is the delivery of 

computing services such as servers, 
storage, databases, networking, 
software, Analytics, intelligence, and 
more, over the Cloud (Internet).

	 2.	 If we choose cloud computing, a cloud 
vendor is responsible for the hardware 
purchase and maintenance. They also 
provide a wide variety of software and 
platform as a service. We can take any 
required services on rent. The cloud 
computing services will be charged 
based on usage.

	 3.	 This service provides an on-demand 
environment for developing, testing, 
delivering, and managing software 
applications. The developer is 
responsible for the application, and 
the PaaS vendor provides the ability 
to deploy and run it. Using Paas, 
the flexibility gets reduce, but the 
management of the environment is 
taken care of by the cloud vendors.

	 4.	 Google Drive is cloud storage 
developed by Google. We can store 
our files online in Google Drive and 
can access them from anywhere in the 
whole world. Drive gives 15 GB of 
free Google online storage. in which 
we can keep files, folder, backups and 
everything that is important.  

E.	1. 	 Opening Google Drive
		  To start Google Drives, open Google 	

	 page in the web browser.
		  1.	 In the Google page, click on 

Signin.  Google account page will 
appear. 

			   You login ID and password are 
same  as that of your Gmail 
account.

		  2.	 Type your login ID and the 
password. Password will appear in 
the form of  black dots.

		  3.	 Click on Next button. Google 
page appears again with your login 
details.

		  4.	 Click on Google Apps button. A 
list of all Google Apps Appears.

		  5.	 Click on Google Drive. Google 
Drive window appears.

	 2.	 To Rename the document
		  1. Click on File menu.
		  2. Click on Raname.
		  3. Type the name, you desire in the 

box.
		  4. Press the enter key.
		  The new name will appear in Docs App. 

CHAPTER-5
COMPUTER VIRUS AND ITS 

DETECTION
A.	1.	 (b)	 2.	 (c)
	 3.	 (c)	 4.	 (c)        5.	 (a)
B.	1.	 Bombs	 2.	 AVG
	 3.	 data	 4.	 speed
	 5.	 Pen drive
C.	1.	 F	 2.	 T
	 3.	 F	 4.	 F 	          5.	T
D.	1.	 Computer virus can harm by modify 

or corrupt files, delete data, steal 
passwords etc.
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		  Some of the routes from which a virus 

can attack a computer are:
		  (i) E-mail.
		  (ii) Infected pen drive & CDs.
		  (iii) Downloading infected files.
		  (iv) Starting an infected application.
	 2.	 Types of computer viruses and their 

effect:
		  (1) Bombs: damage the computer.
		  (2) Boot Sector Virus: damage the 

boot sector  part of  floppy disk.
		  (3) Trojans: destroy data.
		  (4) Worms: spread everywhere and 

affect the speed.
	 3.	 Programs which are used to detect and 

remove viruses.
	 4.	 Norton, AVG, Avast, Kaspersky.
	 5.	 Keyboard & mouse.
E.	(1)	Do your self

CHAPTER-6
COMPUTER ETHICS, 

CRIMEAND SECURITY

A.	1.	 (a)	 2.	 (c)
	 3.	 (c)	 4.	 (b)         5.	 (a)
B.	1.	 illegal	 2.	 Software
	 3.	 copyright	 4.	 warranty
	 5.	 Hardware
C.	1.	 F	 2.	 T
	 3.	 F	 4.	 F          5.	 T
D.	1.	 Software piracy or copyright violation 

refers to the illegal copying and 
distribution of commercial copyright 
without paying for it.

	 2.	 Hacker is person, who breaks into 
computer system to get invalid 
exposure to confidential data and 
information.

	 3.	 Online auction piracy refers to sale of 
a software that is not authorized for 
resale.

	 4.	 Pre-installed software piracy refers 
to invalid installation of a computer 
software on multiple systems by the 
manufacturer.

	 5.	 Cracker is person, who breaks into 
computer system to use passwords, 
files or programs illegally.

E.	Do yourself

CHAPTER-7
BROWSING INTERNET

A.	1.	 (b)	 2.	 (b)
	 3.	 (b)	 4.	 (a)         5.	 (a)
B.	1.	 Contacts	 2.	 acronyms
	 3.	 uppercase	 4.	 E-mail
	 5.	 Copyright
C.	1.	 T	 2.	 F
	 3.	 F	 4.	 T          5.	 T
D.	1.	 Intention to hurt or embarrass other 

persons by sending or posting wrong 
text or images through the internet, is 
known as cyber bullying.

	 2.	 A combination of keystrokes that form 
a sort of picture related to an emotion 
is called emoticon.

	 3.	 Short forms of words used to 
communicate on Internet are known 
as acronyms.

	 4.	 Internet provides an easy way to get 
information from all over the world. 
It provides many facilities like sending 
and receiving messages, greeting cards, 
downloading music, songs or pictures 
and many more.

	 5.	 E-mail address is used to send or 
receive messages.

E.	•	 Do your self

CHAPTER-8
ARTIFICIAL INTELLIGENCE: 

INTRODUCTION
A.	1.	 (d)	 2.	 (d)
	 3.	 (d)	 4.	 (b)        5.	 (d)
B.	1.	 Interpreting
	 2.	 artificial intelligence
	 3.	 fourth industrial revolution
	 4.	 John Mc Carthy
C.	1.	 T	 2.	 T
	 3.	 F	 4.	 T	         5.	 T
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D.	1.	 (a) Human Intelligence:
		  Human intelligence is a mental 

attribute that includes the capacity to 
learn from experience, adapt to new 
conditions, comprehend and handle 
abstract concepts, and manipulate 
one's surroundings using knowledge.

		  (b) Artificial Intelligence
		  Artificial intelligence refers to the 

simulation of human intelligence in 
machines that are programmed to 
third like humans and mimic their 
actions

	 2.	 The phrase "Artificial Intelligence" 
was coined by John McCarthy (1927-
2011), an American Computer 
scientist and cognitive scientist. He 
was a pioneer in the field of artificial 
intelligence. Along With Alan Turing. 
Marvin Minsky, Allen Newell, and 
Herbert Simon, John McCarthy is 
considered one of the "founding 
fathers" of artificial intelligence.

	 3.	 Artificial intelligence (AI) refers to 
a machine's ability to do cognitive 
functions such as thinking, perceiving, 
learning. Problem-solving, and making 
decisions. Originally envisioned 
as a device capable of imitating 
human intelligence. With amazing 
advancements in data gathering, 
processing, and computation power, 
intelligent systems may now be 
deployed to take over a range of jobs, 
enable communication, and boost 
productivity.

	 4.	 Al isn't a well-defined technology, 
and there isn't a single description 
that everyone agrees on. It's more 
of a catch-all word for data analysis 
and pattern detection tools. Artificial 
Intelligence (AI) is a technology that 
has been around since the 1950s. 
Some markets, industries, and 
businesses are further advanced than 
others, because AI is still in its early 
stages of development. There are 

many opportunities for additional 
development and enhancement in 
terms of both the range of possible 
applications and the quality of most 
existing implementations.

	 5.	 Artificial intelligence (AI) is the future 
of all complicated decision-making 
and is the foundation for all computer 
learning. AI is the attempt to make 
computers think and act like humans.

E.	1.	 John McCarthy
	 2.	 Artificial Intelligence.
	 3.	 AI refers to the simulation of human 

Intelligence in machines that are 
programmed to think like humans and 
mimic their actions.

CHAPTER-9
Future of AI and Rise of 

New Technology
A.	1.	 (b)	 2.	 (a)
	 3.	 (a)	 4.	 (a)         5.	 (a)
B.	1.	 virtual mannequin
	 2.	 Journalists	 3.	 AR / VR
	 4.	 virtual reality
	 5.	 Augmented reality
C.	1.	 F	 2.	 T

	 3.	 T	 4.	 T	          5.	T
D.	1.	 The term Artificial Intelligence was 

initially coined by John McCarthy in 
1955, which meant a machine that can 
solve problems that humans perform-
using natural intelligence.

	 2.	 Augmented reality (AR) is an 
enhanced version of the real physical 
world that is achieved through the 
use of digital visual elements, sound, 
or other sensory stimuli delivered via 
technology. It is the integration of 
digital information with the user's 
environment in real time.

	 3.	 Three examples of AR technology are :
		  (a) Pokemon Go
		  (b) Snapchat
		  (c) Google Maps
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	 4.	 Difference between Augmented 

Reality and Virtual Reality:
		  l	 AR uses a real-world setting while 

VR is completely virtual.
		  l	 AR users can control their presence 

in the real world; VR users are 
controlled by the system.

		  l	 AR can be accessed with a 
smartphone while VR requires a 
headset device.

		  l	 AR enhances both the virtual and 
real world while VR only enhances 
a fictional reality.

		  l	 Google Glass is an AR device while 
Oculus Rift is a VR system.

	 5.	 AI applications in healthcare can 
literally change patients' lives, 
improving diagnostics and treatment 
and helping patients and the 
healthcare provider make informed 
medical decisions quickly. Diseases are 
diagnosed more quickly and accurately 
in the relatively new field of healthcare, 
drug discovery is accelerated and 
streamlined, virtual nursing assistants 
monitor patients, and big data 
analysis aids in the creation of a more 
personalised patient experience.

	 6.	 The uses of AI in smart homes are :
		  (1)	 Everything at your fingertips.
		  (2)	 Execute customised schedules.
		  (3)	 Talk to or make your home talk.
		  (4)	 Intelligent protection
		  (5)	 Easy access to the mobile 

encyclopedia.

E. Application Based Question
	 1. 	 VR stands for Virtual Reality, which 

is something that does not exist 
physically but can be visualised and 
experiences.

	 2.	 Virtual reality enables the creation 
of real- life simulations in order to 
provide users with an immersive 
experience that makes them feel as if 
they are actually interacting with the 
digital environment around them.

	 3. Car racing games are an example of 
immersive virtual reality that gives the 
user the sensation of speed and driving 
skills.

CHAPTER-10
AI : Challenges and 

Applications
A.	1.	 (a)	 2.	 (d)
	 3.	 (a)	 4.	 (a)        5.	 (a)
B.	1.	 AI
	 2.	 Reinforcement
	 3.	 Von Neumann
	 4.	 The Turing Test
	 5.	 Speech synthesis
C.	1.	 T	 2.	 T
	 3.	 T	 4.	 F 	         5.	 F
D.	1.	 Artificial Intelligence is the ability 

of a digital computer or computer-
controlled robot that can perform tasks 
generally associated with intelligent 
beings. The term is frequently 
applied to the project of developing 
systems endowed with the intellectual 
processes.

	 2.	 (a)	 Eliminate Dull and Boring 
Tasks: An artificially intelligent 
system will perform and continue 
to perform the task that is assigned 
to it, no matter how many times it 
must do so.

		  (b)	Imitates Human Cognition: 
It is referred to as an artificially 
intelligent system because it 
imitates or mimics the way the 
human mind thinks and solve 
problems.

	 3. Chatbots are software that allows a 
conversation with the user to solve 
any problems they are having, either 
through auditory or texting methods. 
These programmes simulate human 
behaviour while conversing with a 
human via an application. Many 
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businesses, including Swiggy and 
Nykaa, have begun to use chatbots for 
customer service.

	 4.	 There are four types of AI-based 
systems :

		  (1)	Reactive machines: These are the 
most primitive AI systems, with 
extremely limited capabilities. 
They mimic the human mind's 
ability to respond to various 
types of stimuli, Memory-based 
functionality is not available in 
these machines.

		  (2)	Limited Memory: Limited 
memory machines are machines 
that, in addition to having the 
capabilities of purely reactive 
machines, can make decisions 
based on historical data. Almost 
all existing applications that we are 
aware of fall into this category of 
AI.

	 	 (3)	Theory of Mind: While the 
previous two types of AI have been 
and continue to be abundant, 
the next two types of AI exist 
only as a concept or as a work 
in progress for the time being. 
Mental theory AI is the next level 
of artificial intelligence systems 
that researchers are currently 
developing. A theory of mind AI 
will be able to better understand 
the entities with which it interacts 
by determining their needs, 
emotions, beliefs, and thought 
processes.

		  (4)	Self Awareness: This is the 
final stage of AI development, 
which exists only in theory at 
the moment. Self-aware AI is 
an AI that has evolved to be so 
similar to the human brain that 
it has developed self-awareness. 
Developing this type of AI, which 
is decades, if not centuries, away, 
is and will always be the ultimate 
goal of all AI research.

	 5. Turing Test: The Turing test, originally 
called the imitation game was founded 
by Alan Turing an English computer 
scientist, cryptanalyst, mathematician 
and theoretical biologist in 1950, is a 
test of a machine's ability to exhibit 
intelligent behaviour equivalent to, 
or indistinguishable from that of a 
human. It is a method of inquiry 
in artificial intelligence (AI) for 
determining whether or not a 
computer is capable of thinking like a 
human being. The Turing Test judges 
the conversational skill of a bot.

	 6.	 Do Yourself

E.	1. The software engine that drives the 
fourth Industrial Revolution is 
Artificial Intelligence (AI).	

	 2. It holds the promise of resolving some 
of society's most pressing issues.

	 3. Artificial Intelligence face challenges 
such as incomprehensible "black 
box" algorithms, unethical data and 
potential job displacement.

	 4. Its influence is already being felt 
in homes, business and political 
processes.




